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% NCREPT Facility Overview
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NCREPT’s Mission & Focus

Cybersecurity for Energy Delivery Systems

Background:

NCREPT was formed in 2005 as a result of the 2003 Northeast
Blackout and began investigating advanced power electronic
solutions for the grid and transportation applications.

Research Focus:

Design and test advanced, solid-state solutions applicable to:
*» Grid Reliability
*+ Power Interface Applications

*» Transportation
*+ Energy Exploration
s Cybersecurity



Associated Centers

Cybersecurity for Energy Delivery Systems

Cybersecurity Center for Secure Evolvable Energy
Delivery Systems (SEEDS)

GRid-connected Advanced Power Electronics
Systems (GRAPES)

Power Optimization of Electro-Thermal Systems

(POETS) -



https://seedscenter.uark.edu/
http://grapes.uark.edu/
https://poets-erc.org/

NCREPT Facility

Cybersecurity for Energy Delivery Systems _ <

<+ 12,000 square foot building

<+ Cost-effective facility for businesses,
national labs, and universities

<« IEEE 1547 and UL 1741 testing

Parameter

up to 6 MVA (3 x 2 MVA Circuits)
13.8 kV or 4.16 kV (line-line) Variable from 0 V to 15.18 kV

Medium Voltage
Low Voltages (ac 480 V (line-line), Variable from 0 V to 528 V

40 Hz to 70 Hz
Frequency Values outside this range (up to 400 Hz or down to 20 Hz) are possible, but
require de-rating
300 A at 13.8 kV

Currents (ac) 1,000 A at 4.16 kV
2,500 A at 480 V
Loads Active loads fully programmable; Test energy is recirculated

700 kW Resistive Load Bank
Various Passive Components Available
Active Cooling 120 ton Chiller (420 kW Heat Rejection)
2.25 MW (1500 Vdc / 1500 A) [Testing In Progress]
750 kW (660 Vdc / 1.1 kA)
Dynamometer 100 kW with Overload Capability
6,600 rpom @ 220 Nm
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NCREPT Control Room

Cybersecurity for Energy Delivery Systems



NCREPT Bay Area

Cybersecurity for Energy Delivery Systems _ <



NCREPT One-line
Configuration

Cybersecurity for Energy Delivery Systems _ <

Utility Input

LdJd

Utility XFRM (Office)
12.47kV (¥) - 480V (Y)
225kVA [2=2.3%)

50 Feet

Office Power

480V
L3 XFRM (User) T se— L1 XFRM (User)
480(7)-208V(2) I 20;0 Feet 75 Fef‘ | ) 480(8)-208V ()
75KVA[Z=7] 75 kVA [Z = 5.3%]
10 Feet 200 Feet 75 Feet
65 Feet Utility Input
LLJ ity xerm (Testing)
12.47KV (Y) - 480V (Y)
LSMVA[Z=7]
65 Feet
umL
MsB1 MDSC32 480V
40 Feet
F1 F2 [E] F Fs
MDSC16 MDSC16 MDSsC32 MDSC32 MDSC20 MDSC20
80 Feet 120 Feet
3VF L2 XFRM (User)
5 Feet 112.5KVA [2 = 5.2%]
) VWF-DS set
20 Feet
HP1 | 30 Feet 250
12 F13 F14
MDSC32 MDSC32 MDSC32
F11 70 Feet
F9 F10 P vioscs2 70Fest 11 XFRM (User) T2 XFRM (User) 75Feet 13 XFRM (User)
MDSsC32 MDSC32 MDSC32 12.47kV (Y) - 480V (8) 12.47kV (Y) - 480V (8) 12.47kV (Y) - 480V (8)
2.5 MVA [Z = 5.74%) 2.5 MVA[2=5.73%] 2.5 MVA [Z=5.72%)
45 Feet 30 Feet 35 Feet M 70 Feet 65 Feet 60 Feet
Mv3 M2 MV1
MVL 150 VCP-W500 150 VCP-W500 150 VCP-W500 3.8k
—
MVS MV6
Mva L) 150 vCP-W500 bed 150 VCP-W500 150 VCP-W500
150 VCP-WS00
120 Feet
2Mva 2MvA
60 Feet
Mvg MV10
REGEN1 REGEN2 REGEN3 MV2 150 VCP-W500 [ 150 vep-ws00 [ 150 vCP-ws00 13,51V
Inverter :
uuT) MV11 MV12 MV13 Mvi4
40 Feet 60 Feet 60 Feet DC Supply 150 VCP-WS500 150 VCP-W500 150 VCP-W500 150 VCP-W500
750 kW 50 F 0 Fe 50 Fget
F15 F16 F17 s T6 XFRM (User) T5 XFRM (User) T4 XFRM (User)
[ MDSC32 [ WiDSC32 g MDSC32 e ~ 12.47kV (¥) - 480V (, (V) 127KV 450V (8) e 12 47KV (1)~ 480V ()
HP2 o 2.5 MVA [Z = 5.77%] 2.5 MVA [Z=5.79%] 2.5 MVA [2=5.63%]
75 Feet 75 Feet 75 Feet




Examples of Previous
Power Testing

Cybersecurity for Energy Delivery Systems
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Cybersecurity for Energy Delivery Systems

Cyber Testbed
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Cyber Testbed:
Overview and Purpose

Allows for Alpha testing in a realistic environment

Simulated and real-world power flows

Intra and Inter substation topologies emulated

Utilize industry standard communication protocols

IEC 61850
DNP3

OPC UA
Modbus TCP
RS-232

NN

Utilize industry standard hardware devices

v Real-Time Automation Controllers
Protection Relays
PLCs

Security Gateways

RN NIRN

Various Network Devices

Cybersecurity for Energy Delivery Systems

Basic Testbed

R Smart Grid Demo Unit
NCREPT PLC Cabinet 5

NCREPT Low-Voltage Breakers
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Testbed Assets:
Hardware Systems

Cybersecurity for Energy Delivery Systems

480 V LV 3-Phase Breakers [PRs]
> INCOM
» Modbus TCP (PXG900)

13.8 kV MV 3-Phase Breakers [PRs]
> INCOM
» Modbus TCP (PXG900)

Grid Simulator (750 kVA)
» Modbus RTU

Regenerative Load Banks (3 x 2 MVA)

Uility Input

Uity XFRM (Testing)
12,47V (¥) - 480V ()

15MVA[Z=7]
65 Feet
umt
MsB1 MDSC32

» Modbus RTU . L. B B -
MDSC16 MDSC16 MDSC32  DCRegulator | MReci? MDSC20 MDSC20
- e 2 3w L2 XFRM (User)
DC Suppls - 480 (4) - 208V (Y)
PLC Cabinet and SCADA Control o] e I
) VWFDS et
HP1 | F 4sov

> Modbus TCP Jj

| F11
mDsC32

s
mDsc32

w3
MVL 150 VCP-W500
—

p F13 Fia
oS Mosc32 Mosc32
TOFE 1y e (user) TR Taxerm (user) 5Pt 3 e (User)
1384V (Y)- 480V (8) 1384V (1) 480V (0) 138K (¥)- 450V (8)
25 MVALZ=5.74%) 25MVAZ-5.73%] 25 MVA(Z=572%]
5 et 6o eet
w2 w1
150 Ve Ws00 150VeP-Ws00 s
—
s

o L s
» OPCUA o ‘ ?

REGEN3

mva
150 VCP-W500
20 Feet
e
Mv2 150 VCP-W500
—

mv7
150 VCP-W500

13 810y
—

DER Simulator

a0Feet 60Feet

e - woscs2

75 Feet

L
60 Fes
MviL mv12
150 VCP-W500 150VCP-W500
0 Fept Fo e
T6 XFRM (User) TS XFRM (U

jser)
13,80V 1)~ 380V (0 138K (Y) 280V (8]

25 MVA[2=5.77%]

) 1s0veewsoo 150 VCP-W500

o
L2 raxemm (wsen
13.8kV (¥) - 480V (8)

25 MVA[2=5.79%] 25MVA[Z=5.63%]
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Testbed Assets:
Software Systems

Cybersecurity for Energy Delivery Systems  <EEEEEE——
VMWare ESXI Hypervisor

» CheckPoint Security Management Server

» Kali Linux Pen-Testing Server

» GNS3 Network Simulator

» Virtual Routers and Switches

Simulation Resources

> Matlab
> ETAP
» OpenDSS

Remote Access
> Linux and Windows Workstations
» OpenVPN Servers



Testbed Assets:

Cross-Domain Systems

Cybersecurity for Energy Delivery Systems

Available HIL/cHIL Systems at NCREPT
Typhoon HIL
» 6-Series
OPAL-RT
» OP5030 and OP4520
dSPACE
» MicroLabBox

15



Testing Example:
cHIL of 3-Phase Inverter

Cybersecurity for Energy Delivery Systems

LabVIEW/Modbus Control Interface

OPAL-RT IDE and Real-Time Simulation Display

16



Testbed Assets:
Cross-Domain Systems

Cybersecurity for Energy Delivery Systems
HIL Discussion / Benefits

Enables Multi-Feeder Simulation in Real-Time
Analog/Digital I/0 of Voltages/Currents
PTs/CTs of Protection Relays bypassed

IEC 61850 and DNP3 Communications

PR Feedback into Simulation

Shows Greater Grid Impact (PNNL Demo)

17



Integration:
Cyber-Physical Approach

Cybersecurity for Energy Delivery Systems

Cyber-Physical Testing Approach e
» Real Power Flows
»  Grid Simulator

D)

> Regenerative Loads

» Resistive Loads
» Integrated Metering

s Emulated Networks

D)

> Inter and Intra Substation Comms

» Virtual Hypervisor Networking

» GNS3 Network Simulations

» Real-Time Simulations

D)

» Initiate large-scale Fault Scenarios

» Emulate Fault currents Safely

> Virtual Devices



Networking:
Network Segmentation

Cybersecurity for Energy Delivery Systems

Available Networking Resources at NCREPT
<+ Networks
» Four Physical Network Segments
» Virtually Infinite Simulated Networks
<+ VMWare ESXI Hypervisor
» GNS3 Network Simulator
» Virtual Routers and Switches
<+ Remote Access T

e SEED S

Router
(UITS) Standard Work Servers

e E Ui e

> Linux and Windows Workstations
» OpenVPN Servers

NCREPT Switch
(UITS) o

Standard Office Areas

SEEDS Router Equipment Router Production Router
172.16.0.0/12 192.168.100.0/24 192.168.101.0/24
CyberSecurity Equipment | Various Test Equipment Critical Control Equipment

VMware-Based HyperVisor




Protection Relays:
SEL Resources

Cybersecurity for Energy Delivery Systems

20



Real-Time Simulator:
Protection Relay Design

Cybersecurity for Energy Delivery Systems

21



Future Work: Integration

Cybersecurity for Energy Delivery Systems

<« Super Lab and DETER Lab Integration

<+ Investigate integration and collaboration

<+ Multi-Site and International Effort

<+ Unique Challenges for Resource Sharing

Source:



http://www.opal-rt.com/
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Cybersecurity for Energy Delivery Systems

Distributed Energy Resources
> History and Projections
> Example Installations

23



History and Projections:
Solar Energy

Cybersecurity for Energy Delivery Systems

Central and distributed solar energy generation [1]

24



History and Projections:
Wind Energy

Cybersecurity for Energy Delivery Systems

Trends in wind energy generation [2]

25



History and Projections:
Energy Storage

Cybersecurity for Energy Delivery Systems

Central and distributed energy storage [3]

26



Example:
Solar Installation

Cybersecurity for Energy Delivery Systems _ <

% Solar Power is increasing in popularity with home owners and businesses.
» According to a recent article solar utilization has doubled since last year in Arkansas
» It has increased more than 40x since 2007
% Local utilities are also installing solar arrays such as the "Ozark One”
project.
> Residents may participate in this communal solar installation via purchasing shares.
% Communications between inverters and the utility are critical for optimal
operations and accurate billing.

Community Solar Installation

Credit: ozarksecc.com/one 21
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Example:
BESS Installation

Cybersecurity for Energy Delivery Systems

With the increasing penetration of renewable energy, intermittent availability is a
growing issue

More efficient use of generation resources, such as peak shaving techniques,
also contributes to sustainability

Battery Energy Storage Systems (BESS) provide solutions to both of these issues

Advanced Controls, Communication, and Coordination are needed for these
systems to operate properly

Tesla PV Installation Diagram of Energy Generation and Storage
Credit: Tesla Credit: GE

28
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Example DER Cybersecurity Problem
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SCADA Site
Firewall

Server Site Data Router

Manager

Security
Server

Ethernet

2 MW Battery Bank

Corporate
Network

Example DER
Cybersecurity Problem

1

Blockchain Server

Security Module

Corporate

" Internet
Firewall

Corporate
Firewall

Cybersecurity for Energy Delivery Systems

Security Server

Monitoring
and Control

Blockchain Network

Portal
+4-|[+4-|+4-||+4-
125kw____Locus Data e I &
Tnverter (x8) Togger o F—
mp Fuse
3-Phase XFMR 3 MVA
4|+ 4|+ 4-|+4- 480 V Wye to 12.47 kV Wye

; i 12.47 kv

: 3-Phase
125 kW G & Grid

Inverter (x8)

60 Amp Fuse
3-Phase XFMR 3 MVA

480 V Wye to 12.47 kV Wye

&

= 125w
Eﬁﬂ‘ﬂmMmm

‘ Cvhe

60 Amp Fuse
3-Phase XFMR 3 MVA

480 V Wye to 12.47 kV Wye

|

N

HMI

Mitigation

/

\

30
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Advanced Controls for DER
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Advanced Controls

Cybersecurity for Energy Delivery Systems

<+ Need for Secondary and Tertiary Control
» Coordination of Resources for Optimal Power Flow

» Maximize Generation while maintaining Power Quality

<+ Increased Attack Surfaces

32



Advanced Controls

Cybersecurity for Energy Delivery Systems

Control Level Time-Scales. Credit: IEEE Std 2030.7-2017

33
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Attack Scenarios
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SCADA Definition

Cybersecurity for Energy Delivery Systems _ <

*What is SCADA?

»  Supervisory Control and Data Acquisition (SCADA), Process Control System (PCS),
Distributed Control System (DCS), etc. generally refer to the systems which control,
monitor, and manage the nation’s critical infrastructures such as electric power
generators, subway systems, dams, telecommunication systems, natural gas
pipelines, and many others. Simply stated, a control system gathers information and
then performs a function based on established parameters and/or information it
received.

*Source:

H N
i .


https://us-cert.cisa.gov/sites/default/files/documents/Procurement_Language_Rev4_100809_S508C.pdf

Attack Scenario I

Cybersecurity for Energy Delivery Systems _ <

Man-in-the-Middle attack diagram. Credit: OPAL-RT

Man-in-the-Middle (MitM)
A MitM situation occurs when an external attacker is capable of intercepting,
modifying, suppressing or replaying network packets undetected by tricking

two communication nodes to believe they are still communicating normally.
36



Attack Scenario I1

Cybersecurity for Energy Delivery Systems _ <

Denial-of-Service attack diagram. Credit: OPAL-RT

Denial-of-Service (DoS)
DoS can render a service unavailable either through a direct or indirect attack.
It also refers to physical attacks on communication infrastructure, such as the

cutting of wires or wireless jamming.
37



Attack Scenario III

Cybersecurity for Energy Delivery Systems

GPS Spoofing attack diagram. Credit: OPAL-RT

GNSS Spoofing/Meaconing

The act of causing Global Navigation Satellite System (GNSS) receivers to lock
onto simulated or replayed satellite signals instead of real ones, effectively

causing the receiver to locate itself at the wrong position and/or time. This

class of attack is a major threat to PMU and synchrophasor systems, which are
heavily reliant on time synchronization. 38
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Stuxnet Attack

Cybersecurity for Energy Delivery Systems _ <

Stuxnet diagram.
Credit: Trendmicro [7]

Advanced Malware Targeting Industrial Systems [4]
Allowed Access to Discover Facility Architecture
Specific System Function Calls Sent to Field Devices [5]

Destroyed an Estimated 984 Nuclear Centrifuges [6] 7



2015/2016 Ukraine Attack

Cybersecurity for Energy Delivery Systems

< Utilized “Black Energy 3” Malware

<+ Gained Access to Industrial Control
Systems (ICSs)

<+ Target Field Devices Using Custom
Malicious Firmware

< 225,000 Customers Without Power
(1-6 hours)

< 30 Substations Disabled

Overlapping vulnerabilities DoS Attack Utilized bots to “flood” Call/Service centers

and attacks related to - Malicious Firmware Disabled and/or destroyed devices
Ukraine Event. Source: . s fishi Resulted i | idi dential
E-ISAC-TLP Report [8] pearfishing Resulted in employees providing credentials

« Malware Implemented DDoS and Trojan Botnet “Black Energy”



Cyber Kill Chain

Cybersecurity for Energy Delivery Systems _ <

Stage 1: Planning, Preparation, Cyber Intrusion,
Management and Enablement (Explore/Exploit),
Deployment and Entrenchment (Execute Malware)

Stage 2: Attack Development,
Validation, ICS Attack

Diagram of stages of ICS Cyber
Kill Chain. Source: Idaho
National Labs Aug 2016
“INL/EXT-16-40692" [9]

<+ Common Attack Scenario against Utilities

< Incorporates Phishing, Waterhole, Malware, and MiTM Attacks

41



Attacks/Notes

Cybersecurity for Energy Delivery Systems _ <

*» Florida’s Oldsmar Water Treatment System

» Sodium hydroxide, or lye, to more than 100 times normal

» TeamViewer, Potential of shared passwords for remote access
Aurora Generator Test

» 27-Ton Generator vs less than 30 lines of code

» Kinetic Attacks

Bingham County Ransomware

> Brute-Force Attack on Open Port

» Paid Ransom to restore two servers

Coffee Machine Ransomware

» Unencrypted WiFi

» No code signing for firmware updates

s SolarWinds

Software Supply Chain and Firmware Attacks

Compromised update to SolarWinds' Orion software

Currently believed March 2020 Campaign Start Date

Backdoor access to allow credential harvesting and pivoting 42

*
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Solarwinds Orion

Cybersecurity for Energy Delivery Systems _ <

*Source: 43


https://www.fireeye.com/blog/threat-research/2020/12/evasive-attacker-leverages-solarwinds-supply-chain-compromises-with-sunburst-backdoor.html
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Approaches to
Cybersecurity

Cybersecurity for Energy Delivery Systems _ <

Eliminate the Protect the Reduce Segment the React to
Bad Guys Perimeter Vulnerabilities Architecture Breach

*Source: Craig Miller - NRECA

45



Secure Architecture
DeS|gn

Cybersecurity for Energy Delivery Systems
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CISA Best Practices

Cybersecurity for Energy Delivery Systems

s CISA Recommended Practices

Keep Antivirus Software/Definitions Up-to-date
Implement ICS Defense-in-Depth Strategies

Create Cyber Forensics Plans for Control Systems
Develop ICS Cybersecurity Incident Response Plan
OT/IT Collaborations for Proper Firewall Deployment
Patch Management

Secure ICS Modems\Access

Cross-Site Scripting Mitigation

Managing Remote Access to ICS

YVVVYVYVYVYVYY

*Source: https://us-cert.cisa.gov/ics/Recommended-Practices

47



NERC CIP Standards

Cybersecurity for Energy Delivery Systems

«* NERC Current CIP Standards

VVVVVVVYVYVVYYY

NERC CIP-002-5.1a (BES Cyber System Categorization)
NERC CIP-003-8 (Security Management Controls)

NERC CIP-004-6 (Personnel & Training)

NERC CIP-005-6 (Electronic Security Perimeter(s))

NERC CIP-006-6 (Physical Security of BES Cyber Systems)
NERC CIP-007-6 (System Security Management)

NERC CIP-008-6 (Incident Reporting and Response Planning)
NERC CIP-009-6 (Recovery Plans for BES Cyber Systems)
NERC CIP-010-2 (Configuration Change and Vulnerability Assessments)
NERC CIP-011-2 (Information Protection)

NERC CIP-013-1 (Supply Chain Risk Management)

NERC CIP-014-2 (Physical Security)

*Source: https://www.nerc.com/pa/Stand/Pages/CIPStandards.aspx

48



TPM Benefits: Encryption

Cybersecurity for Energy Delivery Systems

WireShark Capture of Unencrypted User Credentials (HTTP)

49



TPM Benefits: Encryption

Cybersecurity for Energy Delivery Systems

WireShark Capture of Encrypted User Credentials (HTTPS)

50
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Research Trends
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CIA Triad Overview

Cybersecurity for Energy Delivery Systems

% Confidentiality of Data
» Authorized Use and
View
» Privacy
% Availability of Data
» Access
» Control
% Integrity of Data
> Validity
» Consistency
> Predictability
% Energy Systems
> Availability of Power
> Integrity of Power

Confidentiality

Availability

Information security CIA Triad
52



Layered Approach
Cybersecurity for Energy Delivery Systems  m————
a Command Layer

* Command Validation

* Communication Encryption
O Supervisory Layer
= Watchdog Timers

= Algorithmic State Machines

Q Control Layer
= Reference Limits
= State Awareness

= Dead Time Enforcement o

Cyber-Secure by Design Layered Approach
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Cyber-Hard by Design

Cybersecurity for Energy Delivery Systems

Robust Protection Requires Multiple Layers
Hardware-Level sub-Module Authentication
» Custom Keys Installed on sub-Modules for Identification
» Encrypted Communication Between sub-Modules
External Authentication
» Certificate Keys Managed by Trusted Certificate Authority
» Custom Hardware Key Required for Firmware Update
» Encrypted Communications for Local/Remote SCADA
Software and Hardware Intrusion Detection
New Encryption Techniques for Higher Performance

Control systems (e.g., state machines) must address all possible
states

Non-sensical/destructive acts must be disallowed by design

54



Cost of Security

Cybersecurity for Energy Delivery Systems _ <

% Processing overhead of encryption < Additional development time of
» Benchmark performances grid-connected power
> Interrupt Service Routine/Polling/Co- electronics
Processor > Possible time savings by
reuse of standard and
% Impact on system operation secure techniques
» Cost/Benefit analysis of securities > Reduced downtime by
» Time delay of communication using robust designs and
» Control algorithm stability with added software
security > Flexible controls to allow
» Additional resources required, upgrades and reduce
increasing cost or lowering replacement of hardware
performance

55
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Summary

Cybersecurity for Energy Delivery Systems _ <

% Penetration of Distributed Energy Resources is Increasing

% Higher-Level Coordination is Required
> Increased Power Quality
> Optimized Power Flow
Coordination Requires Communication
> Peer-to-Peer
» TOU Pricing
> Protection Relays
> Dispatch and Load Predictions
Increased Communications mean Increased Attack Surfaces
> Implement Best Practices to Mitigate Risks

Additional Research Required
> Coordinate Resources
> Optimize Power Flow
> Mitigate Current and Future Risk
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Further Reading & References
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Further Reading
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https://us-cert.cisa.gov/ics/Recommended-Practices
https://us-cert.cisa.gov/ics/Secure-Architecture-Design
https://blog.rsisecurity.com/what-are-the-10-fundamentals-of-nerc-cip-compliance/
https://www.nerc.com/docs/standards/sar/Project_2008-06_CIP-002-4_Guidance_clean_20101220.pdf
https://www.nerc.com/pa/Stand/Pages/CIPStandards.aspx
https://us-cert.cisa.gov/ncas/alerts/aa21-042a
https://us-cert.cisa.gov/sites/default/files/documents/Procurement_Language_Rev4_100809_S508C.pdf
https://www.wired.com/story/how-30-lines-of-code-blew-up-27-ton-generator/
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